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Starry Night  
Activity Directions: 
For Teachers

Introduction
The IA curriculum makes extensive use of the computer program Starry Night. The Starry 
Night activities are not simple demonstrations. They are interactive—students use the 
program to measure and record data for analysis. Students can work off a single interface 
that is projected from a teacher computer, or in small groups on separate computers, such 
as in a computer lab if you have a site license.

Instructions for teachers directing the activities from their home computer are given in 
this document. Investigating Astronomy employs only a few of the features and tools 
available in the Starry Night software package. You are encouraged to explore other 
features on your own and to integrate demonstrations or other visuals into the curriculum 
where appropriate. Whenever you work with Starry Night, remember that the user 
manual can be found beneath the Help menu.

For each activity that involves the collection and analysis of data, students are prompted 
in the text to create a table to use to record their data, or a blackline master can be found 
in the list of materials for the activity. Instruct students to make their table while you are 
setting up the initial location, date, and time specifications for each activity. 

Note: Since this document is a translation of what will be a set of student directions, you 
will find that, instead of student birthdays, other dates have been used. Have students 
change their table column headers to the correct days or dates as needed.

The Basics
You will discover that you perform the same operations time and again in the 11 activities 
that utilize Starry Night to introduce or reinforce important concepts in astronomy. Some 
of the most common manipulations found in these activities are described below. 

a. Setting a Location – Almost every activity begins at some point on Earth, often at the 
location of your school. When you first open the software you will be prompted to set 
your home location. (You can say “Later” when the registration and update boxes 
appear.) For the sake of accuracy, latitude and longitude are the best to use, but choose 
any way that seems sensible to you. After you set your home location, you can always 
return to it by clicking on “Home” in the menu bar or by using the drop-down menu to 
the right of the location box.
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To change location, go to the Options menu bar and select “Viewing Location.” You will 
see a large list of locations, cities, and places such as the North and South Poles. To go the 
equator, use the latitude and longitude option, and type in 0 as a value for latitude. After 
you choose a location you must click on “Set Location.”

 

Most of the work in this course requires students to make observations of objects close to 
the horizon. It is helpful to provide a flat, featureless horizon. To do this go to the Options 
menu and select Other Options/Local Horizon. Then, deselect Photorealistic and check the 
Flat button at the top. This is the box where you can also make the horizon translucent 
so objects such as the sun and moon can be tracked as it dips below the horizon and 
continues on its orbit (Unit 2, Exploration 3, Activity 1, Virtual Moon Journal). Note: 
Leave the “compass points label” box checked at all times.
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b. Moving from Place to Place – Holding the mouse button down and sliding the cursor in 
the direction you wish to observe is a quick and easy way to see other parts of the sky 
or to change your point of view. 

	 To quickly change your view to due East, type “e” and the view will automatically 
center on east. In a similar way, typing “w” will center the view to due west, and so on. 
Or, you can use the buttons in the Gaze box in the menu bar. You can also center on 
your zenith by clicking on the “z” box.

 

c.	Setting the Date and Time – The software always opens to today’s date and time. In 
the Motions unit you will be setting the time to sunrise or sunset. This can be done 
automatically by using the two buttons that are provided. To return to the present date 
and time, use the “Now” button.

 

To change the date and/or time, the easiest way it to click once on the month, date or year 
number you wish to change and then use the up and down arrows on your computer to 
change them. Or, you can use the Time Flow Rate box, which allows you to go forward or 
backward in time incrementally.

 

You often need to change the time increment used in visualizations. The default time 
increment is real time or 1X. To select the appropriate increment use the drop-down 
menu to the right of the Time Flow Rate box. After you set the time, you can use the 
four buttons below to play at that time interval (forward or backward) or to move by 
incremental time steps. To stop the time flow, use the red button. 

At many points in this course, students need to observe the motion of various objects 
in the sky. Sometimes setting the time rate to “Minutes” and then pressing the forward 
arrow will allow for a slow and careful observation. At other times, you might try 
advancing time by hours or days. Again, a shortcut is to highlight the day and then use 
the up and down keys on your keyboard to change the day.

To change to an odd number time interval, for example 3 years, click once on the “1” and 
then hit “y” on your keyboard twice to advance it to 3.
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d. Finding Stars, Planets, and Other Interesting Objects – At times you will want the sky 
to be uncluttered and in its natural state, but often your students will be focusing 
on specific objects like planets or constellations. Planets and moons in the night sky 
should be labeled so you can observe their movement across the celestial sphere. To 
label planets and moons so you can see them on the screen, go to the View menu, 
select “Solar System,” and check “Planets and Moons.” You will see a long menu of 
other items to choose from.

Data on stars, planet, and other objects can easily be obtained by mousing over them. A 
series of data (coordinates like altitude, azimuth, right ascension, distances, etc.) will be 
displayed each time your cursor rests on an object. 

If you wish to search for a particular planet or moon, use the small “Find” tab that is 
found on the left edge of the screen. Type in the name of the object you are looking for 
and select it when it appears in the search box. 

These are just a few of the features of this dynamic software program. Some personal 
investigation of the other tools offered will undoubtedly lead you to some other visuals 
and demonstration you can use to enrich the Investigating Astronomy curriculum.
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Directions for Individual Investigating Astronomy  
Starry Night Activities

Unit 1, Exp. 1, Act. 3, pg.12 
Analyzing the Sun’s Daily Path at Different Times of the Year
Take Home Message(s): The sun rises in different places on the eastern horizon and sets 
at different places on the western horizon throughout the year. The sun’s altitude also 
changes from day to day and is at a maximum in the summer and a minimum in the winter.

Directions:

Before students arrive: Set the day to today and set the location to your school (town or 
latitude and longitude). Place the sun below the eastern horizon a little before sunrise by 
manipulating the Time Flow Rate button one hour at a time.

Watch the sun move across the sky:
1.	Before you move the sun to demonstrate its motion across the sky, ask students: Where 

along the horizon do you think the sun will rise today. (Many will say “in the east.”)

2.	Ask students: How high in altitude do you think the sun reach today? (Many students 
think that the sun is always directly overhead at noon. This is particularly true in areas 
that have a hot, desert climate.)

3.	Advance time slowly so students can find the sun along the horizon. 
•	 Mouse over the bright area. A drop down list of information about the sun should 

appear. 

4.	Under Time Flow Rate near the top of the screen, click on the play button (the right 
pointing triangle).

•	 Students should observe the motion of the sun across the sky. You may have to shift 
(Click and hold down the mouse button and then drag across the screen.) the screen 
as necessary to keep the sun in view. 

5.	Once the sun sets, click on the stop button (the square) under Time Flow Rate near the 
top of the screen.

6.	Reset the time to sunrise.

7.	Show students the daily motion of the sun again.

	 Now set the time interval to 1 hour by clicking on the down pointing triangle under 
Time Flow Rate near the top of the screen. In the drop-down menu that appears, select 
hours. Time Flow Rate should now read “1 hours”. 

Now gather sun position data once an hour throughout the day:
1. Reset the time to sunrise.

2. Make sure students have their tables ready.

3. Mouse over the sun until a drop down list of data appears.

4. Have students record the altitude and azimuth of the sun in their data table.

5. Step time forward one hour by clicking once on the step forward button (the right 
facing triangle with line) under Time Flow Rate near the top of the screen. 

6. Find the altitude and azimuth of the sun again by mousing over the sun. Have students 
record these data. 

7. Repeat this hourly data collection until the sun has set.

8. Have students answer the Pause and Reflect questions or discuss them with the class.

9. If time allows, repeat for a date three months hence.



Investigating Motions of the Sky Investigating Astronomy: Starry Night Activity Directions�

Unit 1, Exp. 2, Act. 2, pg. 20 
Observing the Sun from the Poles and Equator
Take Home Message(s): The path of the sun varies by latitude on Earth. There are times 
of the year when the sun never rises or sets at certain locations on the planet—at or very 
near to the North and South Poles.

Directions:

Before students arrive: Set the location to the North Pole and set the time for 9 AM on 
the day you do the exercise.

1.	Explain to students that first we will have to see if the sun is indeed in the sky at this 
place and time.

•	 Click and hold on the screen and then drag it until you find the sun or are confident 
that it is not visible.

2.	If it is visible, run time forward so students can watch what happens over the course of 
the day: 

•	 Under Time Flow Rate near the top of the screen, click on the play button (the right 
pointing triangle).

•	 If you found the sun, track it across the sky, shifting the screen as necessary to keep 
it in view.

•	 If you didn’t find the sun, tell students to watch the sky and look for the sun to 
appear. 

•	 At the end of the day, stop time again by clicking on the stop button (the square) 
under Time Flow Rate near the top of the screen.

3.	Reset the time to 9:00 AM.

If you found the sun on the screen at any point:

1.	Set the time interval to 3 hours: 

•	 Click on the down pointing triangle under Time Flow Rate near the top of the screen.

•	 In the drop-down menu that appears, select hours.

•	 Click on the number next to the word hours and change it to a 3 using the up and 
down arrows on the keyboard.

2.	Find the altitude and azimuth of the sun at 9:00 AM by mousing over the sun until a 
drop down list of data appears for the sun.

•	 Have students record the altitude and azimuth of the sun in their data table.

3.	Gather sun position data once every 3 hours, as possible, until 9:00 AM on the 
following day: 

•	 Step time forward three hours by clicking on the step forward button (the right 
facing triangle with line) under Time Flow Rate near the top of the screen.

•	 Find the altitude and azimuth of the sun now by again mousing over the sun.

•	 Record these data.

•	 Repeat this, as possible, until 9:00 AM on the following day.

4.	Reset the time to 9:00 AM.

5.	If the sun was not found on your day as viewed from the North Pole, have students 
record this fact.
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Set the location to the South Pole, same day, 9:00 AM.

1.	Near the top of the screen under Viewing Location, click on the down pointing triangle.

2.	In the drop-down menu that appears, select Other.

3.	Search the list for the South Pole.

4.	Click on it and then click on Set Location.

5. Find the sun if possible by clicking on the screen and then drag it until you find the 
sun or are confident that it is not visible.

6. Watch what happens over the course of the day: 

•	 Under Time Flow Rate near the top of the screen, click on the play button (the right 
pointing triangle).

•	 If you found the sun, track it across the sky, shifting the screen as necessary to keep 
it in view.

•	 If you didn’t find the sun, watch the sky and look for the sun to appear.

•	 At the end of the day, stop time again by clicking on the stop button (the square) 
under Time Flow Rate near the top of the screen.

•	 Reset the time to 9:00 AM.

If you found the sun at any point on your day:

1.	Set the time interval to 3 hours by: 

•	 Click on the down pointing triangle under Time Flow Rate near the top of the screen.

•	 In the drop-down menu that appears, select hours.

•	 Click on the number next to the word hours and change it to a 3 by using the up and 
down arrows on the keyboard.

2.	Find the altitude and azimuth of the sun at 9:00 AM: 

•	 Mouse over the sun until a drop down list of data appears for the sun.

•	 Have students record the altitude and azimuth of the sun in their data table.

3.	Gather sun position data once every 3 hours, as possible, until 9:00 AM on the 
following day: 

•	 Step time forward three hours by clicking on the step forward button (the right 
facing triangle with line) under Time Flow Rate near the top of the screen.

•	 Find the altitude and azimuth of the sun now by again mousing over the sun.

•	 Have students record these data.

•	 Repeat this, as possible, until 9:00 AM on the following day.

4.	Reset the time to 9:00 AM.

5.	If the was not found on your day as viewed from the South Pole, have students record 
this fact.

Have students answer the Pause and Reflect questions or discuss them as a group. 
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Part 2
1. Set the location for the equator (O degrees in the latitude box) and the same longitude 

as your school (or any other) and set the date the same as before.

2. If necessary, near the top of the screen under Time and Date, click on the year that is 
showing and use the up and down arrows on the keyboard to change it to the current 
year.

3. Find the time of transit

Find the altitude of the sun at transit:

4. Find the sun in the sky: 

5. Click and hold on the screen and then drag it until you find the sun. 

6. Go to the View menu, choose Alt/Az Guides and select “Meridian.”

7. Advance time until the sun sits on the meridian. This is the time of transit.

8. Mouse over the sun and have students record the sun’s altitude in their data table. 

Gather sun position data at transit once every two weeks for a year: 

1.	Step time forward 14 days by clicking once on the step forward button (the right facing 
triangle with line) under Time Flow Rate near the top of the screen.

2.	Set the time to transit (you must do this for each location.

3.	Find the altitude and azimuth of the sun by again mousing over the sun. 

•	 Record these data.

4.	Repeat this every two weeks throughout the year. 

5.	Have students answer the Pause and Reflect questions or discuss them with the class.
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Unit 1, Exp. 2, Act. 3, pg. 22  
Investigating the Solstices and Equinoxes
Take Home Message(s): The altitude of the sun varies according to the seasons at 
different locations on Earth, with a maximum value on the summer solstice and a 
minimum value on the winter solstice. The sun is never directly overhead if the observer’s 
location is north of the Tropic of Cancer or south of the Tropic of Capricorn.

Directions:

Before students arrive: Set the location to local (your school), set the date to June 21 of 
the present year, the approximate date of the summer solstice. Set the time to transit.

Find the altitude of the sun at transit:

1.	Find the sun in the sky by: 

•	 Click and hold on the screen and then drag it until you find the sun. 

2.	Go to the View menu, choose Alt/Az Guides and select “Meridian.”

3.	Advance time until the sun sits on the meridian. This is the time of transit.

4.	Mouse over the sun to find its altitude and azimuth. 

•	 Have students record the altitude in their data table. 

5.	Change the date to September 21, December 21, and March 21, in turn. 

•	 Check that the year is the current one. If it is not, change it so that it is.

•	 Set the time to transit each day.

each day. (You need to do this each time you change the date.) 

6.	Have students record the altitude of the sun at transit each day.

7.	Change the location to one in the Southern Hemisphere.

•	 Search the list for a city like Melbourne, Australia, or enter the appropriate latitude 
and longitude. 

•	 Click on Set Location.

8.	Change the date to June 21, September 21, December 21, and March 21, in turn. 

•	 Check that the year is the current one. If it is not, change it so that it is.

9.	Set the time to transit each day

10.	Have students record the altitude of the sun at transit each day.

11.	Change the location to the equator and repeat the measurements.

12.	Have students answer the Pause and Reflect questions or go over them in a class 
discussion.
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Unit 1, Exp. 2, Act. 4, pg. 28   
The Reason for the Seasons
Take Home Message(s): The seasons are caused by the tilt of Earth’s axis as it revolves 
around the sun, not by the distance of Earth from the sun.

Directions:

Before students arrive:  
Set the date to the March 21 of the current year, the vernal (spring) equinox.

Find the distance between Earth and the sun: 

•	 Go to View/Alt/Az Guides/Meridian to place the meridian on the screen.

•	 Find the sun and advance time until it sits on the meridian.

•	 Hold the mouse over the sun until the drop down appears.

•	 Have students record the “Distance from sun” in AUs.

Repeat these observations for the other equinox and the two solstices.

•	 Change the date to June 21, September 21, and December 21, in turn.

•	 Hold the mouse over Earth until the drop down appears (after you move the sun to 
transit).

•	 Record the “Distance from sun” in AUs, along with the date of each measurement.

Repeat these observations for at least five other times of year. 

•	 Change the date, selecting dates during different seasons of the year.

•	 Hold the mouse over Earth until the drop down appears.

•	 Record the “Distance from sun” in AUs, along with the date of each measurement. 

Discuss the data with students. Ask:

•	 When is Earth closest to the sun? Farthest?

•	 When Earth is closest to the sun, what season is it in the Northern Hemisphere? In the 
Southern Hemisphere?

•	 When Earth is farthest from the sun, what season is it in the Northern Hemisphere? In 
the Southern Hemisphere?

Have students answer the Pause and Reflect questions or discuss them with the class.
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Unit 1, Exp. 3, Act. 1, pg. 34   
Exploring How and Why the Stars Appear to Move
Take Home Message(s): The paths of stars vary according to geographic location on 
Earth but in each location stars seem to move from east to west as night progresses.

Directions:

Before students arrive: Set the location to the equator at any longitude, the time to 
sunset, and set the screen to the eastern horizon.

Watch the stars as they move across the sky and record data about their paths.

1.	Set the Time Flow Rate to minutes. Click on the play button (the right pointing 
triangle).

2.	As the stars begin to become visible, have students pick one out and follow it.

3.	Have them pick out and follow a few other stars.

4.	Have students draw a diagram of the stars’ paths. 

• Have them label this diagram: Equator Facing East.

5.	Stop time by clicking on the stop button (the square) under Time Flow Rate near the 
top of the screen.

Repeat this while facing south, west, and north.

1.	Change the viewing direction —south, west, and north— in turn. 

2.	Reset the time to sunset.

3.	Under Time Flow Rate near the top of the screen, click on the play button (the right 
pointing triangle).

4.	As the stars begin to become visible, have students pick one and follow it.

5.	Repeat a couple of times.

6.	Have students draw a diagram of the stars’ paths. 

•	 Label each diagram appropriately: Equator Facing _________. 

7.	Stop time by clicking on the stop button (the square) under Time Flow Rate near the 
top of the screen.

Reset the location to your school and the time to sunset.

•	 Face each direction — east, south, west, and north — in turn. 

•	 Under Time Flow Rate near the top of the screen, click on the play button (the right 
pointing triangle). 

•	 As the stars begin to become visible, tell students to pick one and follow it. 

•	 Have students pick and follow a few other stars as you repeat the motion. 

•	 Have students draw a diagram of the stars’ paths. 

•	 Have students label each diagram appropriately: Local Facing ________.

•	 Stop time by clicking on the stop button (the square) under Time Flow Rate near the 
top of the screen.
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Reset the location to the North Pole at 9:00 PM and move the view to one that is 
looking straight up at the zenith (90° altitude). 

Ask students:

•	 Why are we setting the time 9:00 PM instead of sunset, as for the other locations? 
Explain your answer, referring back to what you learned in Explorations One and Two.

•	 The stars visible in the sky on the day you are using. If you were observing on a 
different day, why might they not be visible?

•	 Why are you looking straight up instead of facing east, south, west, and north as for 
the other locations?

Watch the stars as they move across the sky and record data about their paths.

1.	Under Time Flow Rate near the top of the screen, click on the play button.

2.	As the stars begin to become visible, have students pick one and follow it.

3.	Repeat a few times and tell students to pick and follow a few other stars.

4.	Have students draw a diagram of the stars’ paths. 

• Label this diagram: North Pole Looking Straight Up.

5. Have a summary discussion with students about their observations at the various 
locations. 
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Unit 1, Exp. 3, Act. 4, pg. 41   
How the Sun Affects the Visibility of the Stars

Take Home Message(s): The path of the sun across the sky passes through a number of 
constellations that have come to be known as the constellations of the zodiac. The path of 
the sun (and that of all the planets) is called the ecliptic. The stars are still “out” during 
the day. It’s just that the sun is so bright they are hidden from view.

Directions: 

Before students arrive: Set the date to January 1 of the current year, location to local, 
and time to 12:00 PM (noon). Go to the Labels menu and click on Constellations.

You will track the sun in the sky and students will record the constellation in which 
it appears. Ask students:

If you were to look outside at the night sky on January 1, would you see this 
constellation? Explain why or why not. (The constellation would probably set before 
nightfall, depending on its position at noon.)

Shift the date forward, one day at a time, until the sun appears to move into a 
different constellation.
1.	Show students the sun and its position in the sky. Then go to View/Hide Daylight. 

Discuss with students that this is the view we would see without the sun blocking our 
view.

2.	Step time forward one day by clicking on the step forward button (the right facing 
triangle with line) under Time Flow Rate near the top of the screen.

3.	Click on this button over and over again until the sun moves into a new constellation. 

• You may need to shift the screen to keep the sun in view. 

4.	Record the range of dates the sun was in the first constellation.

5.	Record the new constellation in which the sun appears.

6.	Continue this through the entire year and have students place the name of the 
constellations and the dates during which the sun is in each in their tables.

7. Have student answer the Pause and Reflect questions or have a class discussion.
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Unit 1, Exp. 4, Act. 1, pg. 47   
Observing the Planets in Starry Night
Take Home Message(s): The planets roughly follow the same path across the sky—the 
ecliptic. Their daily motion is a result of Earth’s rotation. A planet’s apparent changes in 
motion across the sky over time are a result of Earth’s orbital motion and the motion of 
the planet around the sun.

Directions:

Before students arrive: Set the location to local, date to present day, and time to sunset. 
Go to View/Solar System and check Planets and Moons.

1.	Find at least one planet by clicking and holding on the screen and then dragging it 
until one or more planets come into view. 

2.	Have students watch the planet(s) move across the sky: 

•	 Under Time Flow Rate near the top of the screen, click on the play button (the right 
pointing triangle).

•	 Track the planet(s) across the sky, shifting the screen as necessary to keep the 
planet(s) in view.

•	 If your planet(s) set, look for other planets and track them until sunrise.

3.	Once the sun rises, stop time by clicking on the stop button (the square) under Time 
Flow Rate near the top of the screen.

4.	Have students answer the Pause and Reflect questions or have a class discussion.

Reset the time to 9 PM of the present day.

1.	Find one planet by clicking and holding on the screen and then dragging it until one or 
more planets come into view. 

•	 Decide which planet you are going to observe.

2.	Have students note the position of the planet, relative to the background stars.

3.	Step time forward one day by clicking on the step forward button (the right facing 
triangle with line) under Time Flow Rate near the top of the screen.

4.	Repeat this for two months. 

•	 Students don’t need to record anything, simply move quickly through the days, 
watching the position of the planet.

5.	Ask students: How did the planet appear to move relative to the background of stars?

Pick another planet and repeat the observations.

1.	Note the position of the planet, relative to the background stars.

2.	Step time forward one day at a time for two months, and have students watch the 
position of the planet against the stars.

3. Ask students: How did this planet appear to move relative to the background of stars?

4.	Have students answer the Pause and Reflect questions or have a class discussion.
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Reset the date to the first of the current month (or next) and the time to 9 PM. You 
should still be at you school’s location.

5. Examine the entire visible sky and find and have students record the following:

•	 Which planets are visible?

•	 In which constellation each visible planet is located?

6. Gather 18 months worth of these data for a single planet, moving one month at a time.

•	 To change the month, click on the month that is showing near the top of the screen 
under Time and Date and use the up and down arrows on the keyboard.

7. Have students examine their 18 months of data and look for patterns. (See the Student 
Guide.)

Set the date to June 1, 2007.

1.	Have students mark the starting position of Mars on the Planetary Motions Star Chart 
blackline master.

2.	Change the date to the 1st of the next month. 

•	 Near the top of the screen under Time and Date, click on the month that is showing 
and use the up arrow you the keyboard to move to the following month.

3.	Have students mark the new position of Mars on the sheet.

4.	Have students draw a line connecting these two positions.

5.	Repeat, gathering a full year of data or more.
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Unit 2, Exp. 3, Act. 1, pg. 94   
Virtual Moon Journal
Take Home Message(s): Moon phases are caused by the relative positions of the moon, 
Earth, and the sun.

Directions:

Before students arrive:

1. Click on the Starry Night menu at the top left of the screen. Open the Preferences menu 

2. Near the top of the window that opens, use the drop down menu to change to Cursor 
Tracking (HUD). 

3. Make sure that there are check marks next to the following: 

•	 Altitude

•	 Azimuth

•	 Disk Illumination 

•	 Distance from observer 

4. Uncheck all of the other items. 

5.Close the window.

 

Set the date for November 21, 2006 and the time for 6:30 PM.

6. In a table, have students record the following data in their tables, rounding all 
measurements off to the nearest whole number.

From the top of the screen:
• Date and time (November 21, 2006; 6:30 PM) 

From the drop down that appears when you hold the cursor over the moon:
• Azimuth

• Altitude

• Disk illumination % (the percentage of the moon’s face that you can see)

Note: Distance will be measured later.

7. Have students draw a sketch of the phase of the moon, if possible, in their tables.

8. Find the angular separation between the moon’s position on Day 1 and its position one 
day later by:
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•	 Click on the hand icon in the upper left-hand corner of the screen and change the 
cursor tool to Angular Separation.

•	 Hold your cursor (+) over the center of the moon.

•	 Type “D” on the keyboard. (This advanced time forward by one day.)

•	 Hold the mouse button down and drag your cursor from its position on Day 1 (where 
you placed it in Step 2) to the center of the moon’s position on Day 2 (where it is now).

•	 Have students record the angular separation (distance) you have measured, rounding 
off to the nearest degree. (There are 60 arc minutes in one degree of arc.)

9. Have students record the following data on the moon as you advance the time day after 
day until the moon drops below the eastern horizon:

•	 Date and time (The time will be the same each day.) 

•	 Azimuth

•	 Altitude

•	 Disk illumination %

•	 Sketch of the phase of the moon

•	 Angular Separation between the moon’s positions each day (e.g., Day 2 to Day 3, Day 
3 to Day 4, etc.) 

10.	Repeat this, once a day, until December 4, 2006. Shift the screen, as necessary, to keep 
the moon in view. To do this, use the arrows on the keyboard. You may need to click on 
the screen to make the arrows work. 

11.	Have students answer the Pause and Reflect questions or discuss them as a class. 

Part 2
1. Go to the Options menu, choose Other Options/Local Horizon. Check Flat near the top of 

the screen and change the horizon near the bottom of the screen to Translucent.
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2. In a table, have students record the moon data as before for December 5, 2006 to 
December 21, 2006.

•	 Notice that the degrees of altitude will be negative, indicating how far the moon is 
below the horizon.

•	 Notice also that the azimuth will change uniformly in a positive direction as 
the moon changes position. In effect, you are looking directly through Earth at 
that azimuth, moving northward and then back toward the west, while looking 
downward at the given altitude to locate the moon.

3. Have students answer the Pause and Reflect questions or discuss them as a class. 
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Unit 3, Exp. 2, Act. 1, pg. 155  
Modeling the Orbits of the Planets
Take Home Message(s): The orbits of all the planets are roughly circular when viewed 
from above the plane of the solar system. Distances between Earth and the planets vary 
over time according to the relative positions of the two bodies.

Directions:

Before Students Arrive:

1. Open Preferences under the Starry Night Pro menu.

2. Near the top of the window that opens, change to Cursor Tracking (HUD). 

3. Make sure that there are check marks next to the following: 

•	 Distance from sun 

•	 Name

4. Uncheck all of the other items.

5. Select Brightness/Contrast in the drop down menu. 

6. Under Orbit Line Brightness, change the setting to near, but not all the way, toward the 
Dimmer end.

7. Close the window by clicking on the red circle in the upper left-hand corner.

Set the date to today: 

8. Have students draw and label a diagram on a piece of paper that shows the positions of 
the sun and visible planets. 

Students watch the planets’ movements: Inner Planets

9. Go to the Favourites menu, select Solar System/Inner Planets/Inner Solar System. If 
you are not looking directly above the plane of the solar system, click on the drop down 
menu in the Viewing Location box, choose Other, and then set theta at 90°. Click on Set 
Location. Note: Make sure the View menu says “Stationary Location.”

 

10. Under Time Flow Rate near the top of the screen, set the time interval at 1 day and then 
click on the play button.
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11. Have students observe the planets as they orbit for several complete Earth orbits. 

12. Ask students: How many Earth years does it take for Jupiter to orbit the sun once?

Students watch the planets’ movements: Outer Planets

13. Go to the Favourites menu, select Solar System/Outer Planets/Outer Solar System.

14. Under Time Flow Rate near the top of the screen, set the time interval at 30 day and 
then click on the play button.

15. Have students observe the planets as they orbit for several complete Neptune orbits. 

16. Ask students: How many Earth years does it take for Neptune to orbit the sun once? 
(Students can watch the years tick by in the date box.)

Set the date 3 months from today.

17. Have students draw and label a diagram on a piece of paper that shows the positions of 
the sun and visible planets. Have them title their diagram today plus 3 months.

Part 2 - Have students create a table, to accompany the 
diagram, of the distance between the sun and each planet and 
between Earth and each of the inner planets.
1.	Find the distance between each planet in the inner solar system and the sun by:

•	 Hold the mouse over a planet until the drop down appears.

•	 Have students record the “Distance from sun” in AUs in their tables.

2.	Find the distance between Earth and each of the other planets by: 

• In the upper, left-hand corner, change the hand icon from “Adaptive” to “Angular 
Separation.”

•	 Click on a planet and drag the mouse a short distance. A line and a drop down 
should appear.

•	 Drag the line so that it connects with Earth. A new piece of information, “Distance,” 
should appear in the drop down.

•	 Have students record the “Distance,” which is the distance from Earth, in AUs in 
each case in their tables. 

3.	Have students answer the Pause and Reflect questions or have a class discussion.

Explore how changing the angle at which you are viewing the solar system changes 
the apparent shape of the orbits:

1. Students are currently looking straight down at the solar system.

2. Change the angle of view by doing the following: 

•	 At the right-hand edge of the “Viewing Location” box at the top of the screen, click 
on the down arrow.

•	 Select “Other.” 

•	 Make sure the View menu says “Stationary” and then change the value of Theta to 
“15.”

•	 Click on “Set Location.” 

3. Tell students to observe the apparent shape of the orbit as you move to the new 
viewing position.
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4. Have students draw a diagram on a piece of paper that shows the apparent shape 
of the orbits as viewed from an angle. Ask students what they observe to be the 
general shape of a planetary orbit. (The planets’ orbits are nearly circular, but when 
viewed from an angle, their orbits appear very elliptical. This leads to the “textbook” 
misconception of orbital shape since many graphics show Earth’s orbit at an angle to 
sun-Earth plane.) 
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Unit 3, Exp. 2, Act. 3, pg. 163  
Kepler’s Laws
Take Home Message(s): Kepler’s Laws combine to give the shape of planetary orbits and 
speed of a planet along its orbit, allowing for the prediction of a planet’s position at any 
point of time.

Directions:

Before students arrive: Display the inner planet diagram again. (Favourites/Solar 
System/Inner Planets/Inner Solar System. Use the magnification button (the “+” symbol) 
to zoom in so just the orbit of Mercury so it fills most of the screen.

 

Observe the orbital motion of Mercury:

1.	Under Time Flow Rate near the top of the screen set the time interval to 6 hours then 
click on the play button.

2.	Have students observe Mercury as it orbits. Ask students:

• Where in Mercury’s orbit is it moving fastest?

• Where is it moving slowest? 

3.	Stop the movement through time by clicking on the stop button (the square under Time 
Flow Rate). 

Record Mercury’s distance from the sun:

1.	Position Mercury to where it seems to be moving fastest by: 

•	 Under Time Flow Rate near the top of the screen, stepping through time by clicking 
on the bar-triangle buttons.

2.	Find the distance between Mercury and the sun at this position by: 

•	 Holding the mouse over Mercury until the drop down appears.

•	 Have students record the “Distance from sun” in AUs. 

3.	Repeat this for where Mercury seems to be moving slowest. 

Observe the orbital motion of Earth:

1.	Use the un-zoom button (the “-“symbol) and set the time interval to one day. Click on 
the play button.

2.	Have students observe Earth as it orbits. 

•	 Can you tell where in its orbit Earth is moving the fastest? The slowest? (Students 
won’t be able to tell since the eccentricity of Earth’s orbit is too small. For all 
practical purposes Earth’s orbit appears as a perfect circle. Having Mercury and 
Mars in the same frame makes for a good comparison.)

3.	Stop the movement through time by clicking on the stop button. 
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Observe the orbital motion of Jupiter:

1.	Change to the outer solar system frame (Favourites/Solar System/Outer Planets/Outer 
Solar System). Under Time Flow Rate near the top of the screen, click on the play 
button.

2.	Have students observe Jupiter as it orbits. 

• 	Does Jupiter appear to be moving fast or slow relative to Earth and Mercury?

3. Click on the Find box at the left edge of the screen. Put “Pluto” in the search box. Check 
both of the little boxes next to the dwarf planet’s name. Pluto and its orbit will appear 
on the outer planet diagram.

 

4. Set the time flow rate to years and click on the play button.

5. Have students observe the motion of Pluto and see if they can identify perihelion 
(fastest) and aphelion (slowest). They might notice that the orbit of Pluto is inside of 
Neptune’s orbit for about 20 years of its 248 year trip around the sun.
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6. Have students measure the perihelion distance and aphelion distance for Pluto.  
Extra Credit: Have students calculate the eccentricity of Pluto.

7. Go to the drop-down menu to the right of the Location box again and choose Other. 
Change theta to 0. This will place the solar system view to edgewise. Set the time flow 
to years and click the on button. 

8. Have students estimate the inclination of the orbit of Pluto (Actual value = 17°). 
Discuss why most astronomers believe that Pluto was captured after the formation of 
the solar system.

9. Have students answer the Pause and Reflect questions.

 




